Cummins INLINE™ 7 Data Link Adapter Installation and Setup Manual. The Cummins INLINE™ 7 was designed and manufactured by IDSC Holdings LLC for Cummins Inc.

IDSC Holdings LLC retains all ownership rights to INLINE 7 Data Link design and its documentation. The INLINE 7 Data Link source code is a confidential trade secret of IDSC Holdings LLC. You may not decipher or de-compile the INLINE 7 Data Link Adapter, develop source code for the INLINE 7 Data Link Adapter, or knowingly allow others to do so. The INLINE 7 Data Link Adapter and its documentation may not be sublicensed or transferred without the prior written consent of IDSC Holdings LLC.

This manual, as well as the software it describes, is furnished under license and may only be used or copied in accordance with the terms of such license. The content of this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment by IDSC Holdings LLC. IDSC Holdings LLC assumes no responsibility or liability for any errors or inaccuracies that may appear in this book.

Except as permitted by such license, no part of this publication may be reproduced, or transmitted, in any form or by any means, electronic, mechanical, or otherwise, without the prior written permission of IDSC Holdings LLC.

The Cummins logo and INLINE 7 are trademarks of Cummins, Inc. The Bluetooth word mark and logos are registered trademarks owned by Bluetooth SIG. Other trademarks and trade names are those of their respective owners.

©2016 IDSC Holdings LLC. All rights reserved. All other marks are trademarks or registered trademarks of the respective holders. Pictures for illustration purposes only. Specifications are subject to change without notice.

The transmitter modules contained in this product comply with regulatory standards EN 300 328 and EN 301 489-1/-17. Human exposure of these modules is below the SAR limits specified in EU recommendation 1995/519/EC.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation. A distance of 20cm minimum should be maintained between the product and all persons during operation. This device contains FCC-IDs: 2AJFJ-USBL2-IL7, QOQWT41.

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Part No. 965062 Revised 02/20/2018
# Table of Contents

Chapter 1:  
Using this Manual 1  

- Manual Overview ...........................................................................................................2  
- Conventions ...................................................................................................................3  

Chapter 2:  
Introducing the Cummins INLINE™ 7  
Data Link Adapter ......................................................................... 5  

- Component Checklist .................................................................................................6  
- Product Specifications ...............................................................................................7  
- System Requirements .................................................................................................8  
- Device Features .........................................................................................................9  
- Communication Options: Wired vs Wireless .........................................................13  
  - Wired USB Connection ............................................................................................13  
  - Wireless Bluetooth Connection ...............................................................................14  
  - Wireless Wi-Fi Connection .....................................................................................15  
  - Mini Access Point Mode (Peer-to-Peer) .................................................................16  
  - Infrastructure Mode (Connecting to your Company’s Network) ..........................17  

Chapter 3:  
Installing the Drivers and Setting Up the Device ............................. 19  

- Installation Process Outline .......................................................................................20  
- Step 1: Install the Drivers ..........................................................................................21  
- Step 2: Connect the INLINE™ 7 to a Vehicle ..........................................................30  
  - Making a Wired USB Connection ...........................................................................31  
  - Making a Wireless Bluetooth Connection .............................................................32  
  - Connecting via a Class 1, External Bluetooth Adapter ..........................................32  
  - Pair the Device .......................................................................................................35  
  - Making a Wireless Wi-Fi Connection .....................................................................39  
  - Mini Access Point Mode .........................................................................................39  
  - Infrastructure Mode ................................................................................................43
# Table of Contents

Step 3: Test the Connection ..........................................................44
Using the Cummins INLINE™ 7 Explorer Utility ..........................48
   The Configuration Tab .................................................................50
   Switching Modes: Mini Access Point and Infrastructure ..........51
The File Menu ..................................................................................53
The Tools Menu ...............................................................................54
   Ping ..........................................................................................54
   Options .......................................................................................55
      Start INLINE7 Explorer when Windows Starts ......................55
      Show New INLINE7 Notification ............................................56
The Help Menu ................................................................................57
Using this Manual

- Manual Overview, page 2
- Conventions, page 3

This chapter provides an overview of this manual’s organization and the conventions used throughout.

**NOTE:**

Screen shots used throughout this manual are for illustrative purposes only. All data shown is fictitious in nature.
Manual Overview

This manual provides basic and detailed information to support you during installation and setup of the Cummins INLINE™ 7 Data Link Adapter.

This manual is composed of the following sections:

- **Table of Contents**—helps you to find the information you are looking for quickly and easily.

- **Chapter 1: Using this Manual**—provides an overview of this user’s manual.

- **Chapter 2: Introducing the Cummins INLINE™ 7 Data Link Adapter**—provides details regarding the communication modes available to you to interface with your PC. It also introduces the features of the INLINE™ 7 (i.e., the LEDs, the Reset Button, the USB port, and the Vehicle port).

- **Chapter 3: Installing the Drivers and Setting Up the Device**—provides instructions for installing INLINE™ 7 drivers and utilities, connecting the INLINE™ 7 Data Link Adapter to a vehicle, connecting to a wireless network, and testing the connection. It also provides information on using the Cummins INLINE™ 7 Explorer utility.

Each chapter begins with an “at-a-glance” list of the chapter contents, along with corresponding page numbers.
Conventions

This section provides descriptions of the conventions used throughout this guide.

Special Messages

Note

NOTE provides an explanation, comment, or tip related to the subject matter that is being discussed.

Example:

NOTE:

Refer to the page number provided for each described component for further details.

Important

IMPORTANT indicates a situation which, if not avoided, may result in damage to the test equipment or vehicle.

Example:

IMPORTANT:

Keep all cables clear of moving or hot engine parts.

Caution

CAUTION indicates a potentially hazardous situation which, if not avoided, may result in moderate or minor injury to the operator or to bystanders.

Example:

CAUTION:

Do not use the unit to perform tests on household or industrial sources.
### Warning

WARNING indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury to the operator or bystanders.

*Example:*

```
WARNING:  
All RP1210 adapters must be disconnected before proceeding with installation.
```

### Troubleshooting

Information intended to help you to address or anticipate potential issues are presented in the following manner:

```
Check to make certain that the Power LED on the INLINE™ 7 is illuminated.
```

### Specialized Text

The following specially formatted text is used to help you to differentiate certain elements discussed within this manual:

- **Emphasis:** Used to draw your attention to particularly important information.

  Example: “Click on the Finish button to continue.”

- **FEATURE:** Used to highlight the name of a specific feature.

  Example: “From the Start menu, select Programs ▶ Cummins ▶ INLINE 7 ▶ CumminsValidationTool”

- **Field/Line:** Used to highlight the name of a field or a line of text from a display.

  Example: “Place a check mark in the Always trust software from IDSC Holdings LLC check box.”

- **Menu Items:** Used to highlight a series of menu selections.

  Example: “The Installation Complete screen is displayed.”
Introducing the Cummins INLINE™ 7 Data Link Adapter

The INLINE™ 7 Data Link Adapter is a hardware device that enables service bay personal computers (i.e., PCs and/or laptops) to retrieve vehicle information using either wireless Bluetooth® technology, a more traditional cable connection, or Wi-Fi. Once configured, the INLINE™ 7 interfaces with your PC, enabling you to use specific PC applications to perform vehicle diagnostics.

This chapter introduces the Cummins INLINE™ 7 Data Link Adapter and provides details regarding the communication modes available to you to interface with your PC. It also introduces the features of the INLINE™ 7 (i.e., the LEDs, the Reset Button, the USB port, and the Vehicle port).
Component Checklist

The following components are included with your Cummins INLINE™ 7 Data Link Adapter. Be sure you have all of the following items before using the device:

- INLINE™ 7 Data Link Adapter
- Automotive A to Mini-B USB Cable (see Figure 2.2)
- 6- and 9-pin “Y” Deutsch Adapter
- 2-pin Delphi/3-pin Deutsch Adapter (with battery clips)
- Carrying Case
- Cummins INLINE™ 7 Quick Start Guide

NOTE:

INLINE™ 7 drivers and a portable document format (PDF) version of this manual are available for download at the Cummins website:

http://cumminsengines.com/inline-manuals
**Product Specifications**

The INLINE™ 7 Data Link Adapter is configured with the following specifications:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Physical Dimensions</strong></td>
<td>6.75&quot; x 3.75&quot; x 1.06&quot; (171 mm x 95 mm x 27 mm)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>8 oz. (0.22 kg)</td>
</tr>
<tr>
<td><strong>Power Requirements</strong></td>
<td>6 - 32 VDC @ 350 mA maximum</td>
</tr>
<tr>
<td><strong>Operating Temperature</strong></td>
<td>0 to +70 °C</td>
</tr>
<tr>
<td><strong>API Driver</strong></td>
<td>TMC RP1210A, RP1210B, and RP1210C compliant</td>
</tr>
<tr>
<td><strong>Vehicle Protocols Supported</strong></td>
<td>• J1708/J1587</td>
</tr>
<tr>
<td></td>
<td>• J1939 (250K, 500K, or 1 MB)</td>
</tr>
<tr>
<td></td>
<td>• CAN (125K, 250K, 500K, 1 MB)</td>
</tr>
<tr>
<td></td>
<td>(3 CAN channels with Auto Baud)</td>
</tr>
<tr>
<td></td>
<td>• ISO 9141</td>
</tr>
<tr>
<td></td>
<td>• ISO 14230 (KWP2000)</td>
</tr>
<tr>
<td></td>
<td>• ISO 15765</td>
</tr>
<tr>
<td><strong>USB Communication</strong></td>
<td>USB Device, version 1.1</td>
</tr>
<tr>
<td><strong>USB Connector</strong></td>
<td>Latching USB Mini-B</td>
</tr>
<tr>
<td><strong>Wired Communication</strong></td>
<td>Automotive A to Mini-B USB cable 13 ft. (4 m) maximum</td>
</tr>
<tr>
<td><strong>Wireless Communication</strong></td>
<td>• Bluetooth® Class 1 adapter (up to 100 m range)</td>
</tr>
<tr>
<td></td>
<td>• Dual band Wi-Fi (802.11 a/b/g/n)</td>
</tr>
<tr>
<td><strong>Vehicle Connector</strong></td>
<td>High Density D-sub 26-pin Male (HD26M)</td>
</tr>
</tbody>
</table>
## System Requirements

Be aware of the following system requirements:

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| IBM PC-compatible computer             | • 1GHz processor or more  
• RAM: 256MB or more (512MB recommended)  
• USB port, version 1.1 or higher  
• Wi-Fi card                                   |
| Operating system                       | • Windows® 7  
• Windows® 8  
• Windows® 10                                                   |
| Bluetooth® adapter (sold separately)   | • Bluetooth® Class 1 USB Adapter (up to 100m range)                          |
|                                        | **Note:** PCs that have Integrated Bluetooth typically use a Class 2 Bluetooth® module, which has limited range (typically 10m). |
| Wi-Fi wireless network                 | • Dual band Wi-Fi (802.11a, b, g, or n)                                      |
Device Features

The following illustration details the features of the INLINE™ 7 device.

Figure 2.1 Cummins INLINE™ 7 Data Link Adapter

Legend

A—Vehicle Port  D—Wireless Comm LED
B—Power LED  E—Fault LED
C—Vehicle Data LED  F—USB Port
Chapter 2 • Introducing the Cummins INLINE™ 7 Data Link Adapter

The following features behave the same whether the device is in Bluetooth® or Wi-Fi mode:

<table>
<thead>
<tr>
<th>Feature</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vehicle Port</td>
<td>Connects the INLINE™ 7 to a vehicle/engine for power and data.</td>
</tr>
<tr>
<td>Power LED</td>
<td>Illuminates when the device receives power.</td>
</tr>
<tr>
<td>Vehicle Data LED</td>
<td>Illuminates when the device is receiving data from the vehicle.</td>
</tr>
<tr>
<td>Fault LED</td>
<td>Illuminates when a problem is detected.</td>
</tr>
<tr>
<td>USB Port</td>
<td>Connects the device to your PC (wired connection).</td>
</tr>
<tr>
<td></td>
<td>Latching USB Mini-B Connector for connection to PC host. Not used with iOS device.</td>
</tr>
</tbody>
</table>

The Wireless LED and the Reset Button, however, behave differently depending on which mode (i.e., Bluetooth or Wi-Fi) the device is in.

<table>
<thead>
<tr>
<th>Feature</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless Comm LED: Blue: Bluetooth Mode</td>
<td>If the device is Discoverable:</td>
</tr>
<tr>
<td></td>
<td>• Illuminates solid blue when connected.</td>
</tr>
<tr>
<td></td>
<td>• Blinks every second when not connected.</td>
</tr>
<tr>
<td></td>
<td>If the device is Non-Discoverable:</td>
</tr>
<tr>
<td></td>
<td>• Illuminates blue when connected.</td>
</tr>
<tr>
<td></td>
<td>• Off when not connected.</td>
</tr>
<tr>
<td>Wireless Comm LED: White: Wi-Fi—Mini Access Point Mode</td>
<td>Mini Access Point Mode:</td>
</tr>
<tr>
<td></td>
<td>• Illuminates solid white when a client PC connects to the device.</td>
</tr>
<tr>
<td></td>
<td>• Off when no client PC is connected.</td>
</tr>
</tbody>
</table>
### Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wireless Comm LED:</td>
<td><strong>Infrastructure Mode:</strong></td>
</tr>
<tr>
<td>Orange: Wi-Fi—Infrastructure Mode</td>
<td>• Stays off when not associated with a network Access Point.</td>
</tr>
<tr>
<td></td>
<td>• Blinks every second when associated with an access point, but no IP address assigned.</td>
</tr>
<tr>
<td></td>
<td>• Illuminates solid orange when successfully assigned an IP address.</td>
</tr>
<tr>
<td>Reset Button</td>
<td>The INLINE™ 7 factory default is Bluetooth mode in a Non-Discoverable status. To confirm that the device is in Bluetooth mode, press the Reset button momentarily and the Wireless LED will illuminate blue.</td>
</tr>
<tr>
<td>Bluetooth Mode</td>
<td>In Bluetooth mode, the Reset button is used to change the status of the device. The two status modes are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Non-Discoverable</strong>—When the INLINE™ 7 is Non-Discoverable, it will only connect to a host device with which it has previously been paired.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Discoverable</strong>—When the INLINE™ 7 is Discoverable, a host device can detect, pair, or connect to it.</td>
</tr>
<tr>
<td></td>
<td>To change the mode from Non-Discoverable to Discoverable, press and hold the Reset button until the Wireless LED begins to flash blue (about 3 seconds).</td>
</tr>
<tr>
<td></td>
<td>Once a connection is established, the LED turns solid blue. After two minutes, discoverability will time out, and the device will go back to Non-Discoverable status.</td>
</tr>
</tbody>
</table>
### Chapter 2 • Introducing the Cummins INLINE™ 7 Data Link Adapter

#### Reset Button

**Wi-Fi Mode**

When using Wi-Fi, the INLINE™ 7 can be configured for either of the following modes:
- Mini-Access Point (Wi-Fi default)
- Infrastructure

**Note:** INLINE™ 7 cannot be used in Infrastructure mode until it has been configured using the Explorer utility (see *Using the Cummins INLINE™ 7 Explorer* in Chapter 3 of this manual).

Once Infrastructure mode has been configured, you can switch between Mini-Access Point and Infrastructure modes by pressing and holding the Reset button for three (3) seconds. The LED will change color to indicate the mode change.

#### Reset Button

*(to switch modes)*

The Reset button is also used to switch back and forth between Bluetooth and Wi-Fi modes.

To switch modes, press and hold the Reset button for about ten (10) seconds. All LEDs will flash momentarily to indicate that the device has been reconfigured and reset.

Once the device reboots, the color of the Wireless LED will reflect the wireless mode:
- **Blue** = Bluetooth mode
- **White** = Wi-Fi, Mini Access Point mode
- **Orange** = Wi-Fi, Infrastructure mode

<table>
<thead>
<tr>
<th>Feature</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset Button</td>
<td><strong>Wi-Fi Mode</strong></td>
</tr>
<tr>
<td></td>
<td>When using Wi-Fi, the INLINE™ 7 can be configured for either of the following modes:</td>
</tr>
<tr>
<td></td>
<td>• Mini-Access Point (Wi-Fi default)</td>
</tr>
<tr>
<td></td>
<td>• Infrastructure</td>
</tr>
<tr>
<td><strong>Note:</strong> INLINE™ 7 cannot be used in Infrastructure mode until it has been configured using the Explorer utility (see <em>Using the Cummins INLINE™ 7 Explorer</em> in Chapter 3 of this manual).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Once Infrastructure mode has been configured, you can switch between Mini-Access Point and Infrastructure modes by pressing and holding the Reset button for three (3) seconds. The LED will change color to indicate the mode change.</td>
</tr>
<tr>
<td>Reset Button</td>
<td><em>(to switch modes)</em></td>
</tr>
<tr>
<td></td>
<td>The Reset button is also used to switch back and forth between Bluetooth and Wi-Fi modes.</td>
</tr>
<tr>
<td></td>
<td>To switch modes, press and hold the Reset button for about ten (10) seconds. All LEDs will flash momentarily to indicate that the device has been reconfigured and reset.</td>
</tr>
<tr>
<td></td>
<td>Once the device reboots, the color of the Wireless LED will reflect the wireless mode:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Blue</strong> = Bluetooth mode</td>
</tr>
<tr>
<td></td>
<td>• <strong>White</strong> = Wi-Fi, Mini Access Point mode</td>
</tr>
<tr>
<td></td>
<td>• <strong>Orange</strong> = Wi-Fi, Infrastructure mode</td>
</tr>
</tbody>
</table>
Communication Options: Wired vs Wireless

Prior to using the INLINE™ 7, you need to decide how you want the unit to communicate with your PC. There are three options:

- Wired, USB Connection (pg. 13)
- Wireless, Bluetooth® Connection (pg. 14)
- Wireless, Wi-Fi Connection (pg. 15)

Wired USB Connection

A wired USB connection provides the advantages of high data throughput, low latency, and a high-reliability data connection.

IMPORTANT:

ECU reprogramming typically requires both high throughput and critical timing, and should always use a USB-to-PC wired connection.

Wired communication between the INLINE™ 7 and your PC requires an automotive A to Mini-B USB cable (shipped with the INLINE™ 7).

NOTE:

For detailed instructions on making a wired connection, refer to Making a Wired USB Connection in Chapter 3 of this manual.
Wireless Bluetooth Connection

The INLINE™ 7 can be configured to use Bluetooth® wireless technology to provide communication between the INLINE™ 7 and your PC. Bluetooth® has limited bandwidth and exhibits latency when compared to WI-FI or a wired USB connection. This may result in dropped messages in situations requiring high bandwidth.

The INLINE™ 7 Data Link Adapter is equipped with a Class 1 Bluetooth® module with a range of up to 100m when communicating with another Class 1 Bluetooth® device. Most PCs that feature Integrated Bluetooth® are equipped with a Class 2 Bluetooth® module, which limits the useful range to around 10m.

NOTE:

For maximum wireless range, the use of an external, Class 1 USB Bluetooth® adapter (sold separately) is recommended.

If you decide to employ an external, Class 1 USB Bluetooth® adapter, you will have to perform the following tasks:

• Disable the integrated Bluetooth® device
• Install the drivers supplied with the external adapter
• Configure the Bluetooth® environment.

For detailed instructions on configuring the INLINE™ 7 for Bluetooth®, see Making a Bluetooth Wireless Connection, in Chapter 3 of this manual.
Wireless Wi-Fi Connection

The INLINE™ 7 can also be configured to use Wi-Fi to provide wireless communication between the INLINE™ 7 and your PC.

There are two network options:

- Mini Access Point Mode (pg. 16)
- Infrastructure Mode (pg. 17)

Wi-Fi performance can be affected by network congestion or radio frequency interference if there are too many other wireless devices in the vicinity. These conditions may result in dropped messages. For this reason, Wireless communication is not recommended for ECU reprogramming (i.e., reflashing).
Mini Access Point Mode (Peer-to-Peer)

The easiest and quickest way to connect your INLINE™ 7 to your PC is Mini Access Point mode. In Mini Access Point mode (also known as Access Point Emulation mode), the PC communicates directly with the INLINE™. The INLINE™ 7 emulates the function of an access point, allowing the PC to connect directly to the INLINE™ 7, as if it were an access point. When the PC is connected to the INLINE™ 7 in Mini Access Point mode, neither device is connected to the company network.

![Mini Access Point Mode Diagram](image)

If you use your PC's internal wireless network card to connect to your company's network and the Internet, you may want to obtain an additional wireless network card for use with the INLINE™ 7. Otherwise when you connect the INLINE™ 7 to your PC using Mini Access Point mode, you will not have access to the Internet until you have finished your session and reconnected to your company's network.
For instructions on connecting the INLINE™ 7 Data Link Adapter and your PC using Mini Access Point Mode, see Connect Using Wi-Fi, in Chapter 3 of this manual.

**Infrastructure Mode (Connecting to your Company's Network)**

In Infrastructure mode, your PC communicates with your company's computer network through a Wireless Access Point (not included), which acts as a bridge between the wireless network and the wired network. In this mode, the INLINE™ 7 is configured to communicate with the same access point. All communication between the PC and the INLINE™ 7 passes through the access point.

![Figure 2.4 Infrastructure Mode](image)

**NOTE:**

The settings for connecting to your company network may differ from one installation to another. To ensure network security, your Information Technology (IT) administrator will need to oversee the installation and specify the appropriate configuration parameters. Your IT administrator should be able to properly configure the INLINE™ 7 for infrastructure mode, using the INLINE™ 7 Explorer utility (see Switching Modes: Mini Access Point and Infrastructure in Chapter 3 of this manual).
Chapter 3

Installing the Drivers and Setting Up the Device

- Installation Process Outline, pg. 20
- Step 1: Install the Drivers, pg. 21
- Step 2: Connect the INLINE™ 7 to a Vehicle, pg. 30
  - Making a Wired USB Connection, pg. 31
  - Making a Wireless Bluetooth Connection, pg. 32
    - Connecting via a Class 1, External Bluetooth Adapter, pg. 32
    - Pair the Device, pg. 35
  - Making a Wireless Wi-Fi Connection, pg. 39
    - Mini Access Point Mode, pg. 39
    - Infrastructure Mode, pg. 43
- Step 3: Test the Connection, pg. 44
- Using the Cummins INLINE™ 7 Explorer Utility, pg. 48

This chapter provides instructions for installing Cummins INLINE™ 7 drivers and utilities, connecting the INLINE™ 7 Data Link Adapter to a vehicle, connecting to a wireless network, and testing the connection. It also provides information on using the Cummins INLINE™ 7 Explorer utility.

NOTE:

Screen shots used throughout this manual are for illustrative purposes only. All data shown is fictitious in nature.
Installation Process Outline

Step 1: Install the INLINE™ 7 drivers (pg. 21).

Step 2: Connect the INLINE™ 7 Data Link Adapter to the vehicle (pg. 30).
   Connect to your PC using one of the following options:
   • A wired, USB connection (pg. 31)
   • A wireless, Bluetooth® connection (pg. 32)
   • A wireless, Wi-Fi connection
      There are two options:
      — Mini Access Point Mode (pg. 39)
      — Infrastructure Mode (pg. 43)

Step 3: Test the connection between the INLINE™ 7 and the vehicle using the Cummins Communication Validation Tool (pg. 44)

NOTE:
If you have questions about using this product, call 1-800-433-9341
Step 1: Install the Drivers

Prior to using the INLINE™ 7, you have to install the necessary INLINE™ 7 drivers. The INLINE™ 7 drivers are compatible with Microsoft® Windows® 7, Windows® 8, and Windows® 10.

IMPORTANT:

⚠️ Remember, you must have Administrator security rights and be logged in as “Admin” to successfully complete the installation process outlined in this manual.

The following procedure assumes that you have Internet access.

To install the drivers on your laptop or PC:

1. On your laptop or PC, navigate to the following website:
   http://cumminsengines.com/inline-downloads

2. Select the latest version of the INLINE™ 7 drivers.

3. Click on Open to open the .zip file.

4. Double-click on the .exe file to run the install.
The **Welcome to INLINE™ 7 Setup** screen is displayed.

![Welcome to Cummins INLINE 7 Setup Screen](image)

**Figure 3.2** Welcome to Cummins INLINE 7 Setup Screen

5 Carefully read the information displayed on the screen, and follow the recommendations.

6 Click **Next**.
The **License Agreement** screen is displayed.

![Figure 3.3 License Agreement Screen](image)

7 Read all the information on this screen, then click **I Agree**.

**NOTE:**

If you do not agree to the terms, click **Cancel**. A message is displayed prompting you to confirm quitting INLINE™ 7 Setup. Click **Yes** to quit.
The following warning message is displayed.

![Warning Message](image)

**Figure 3.4 Warning Message**

8 Carefully read the warning message, and disconnect all RP1210 adapters to which your laptop or PC might be connected prior to proceeding with the installation.

9 Once you have complied with the requirements of the warning message, click OK.
The installation begins and the following screen is displayed.

Figure 3.5 Installation Screen
Chapter 3 • Installing the Drivers and Setting Up the Device

If you are running Windows® 7 or Windows® 8, the following Windows Security dialog may be displayed.

![Windows Security Dialog](image)

**Figure 3.6 Windows Security Dialog**

---

**NOTE:**

You may want to place a check mark in the **Always trust software from “Jungo LTD”** check box. If you leave it unchecked, this dialog may be displayed more than once.

10 Click **Install** to continue.

11 Wait briefly while the installation continues.
The **Installation Complete** screen is displayed.

![Installation Complete Screen](image)

**Figure 3.7** *Installation Complete Screen*

12 Click **Next**.
The following completion screen is displayed.

![Completion Screen](image)

**Figure 3.8 Completion Screen**

13 Click **Finish**.
The **Cummins INLINE™ 7 Explorer** utility opens.

**Figure 3.9** Cummins INLINE™ 7 Explorer Utility

**NOTE:**

For information on using the Cummins INLINE 7 Explorer, see *Using the Cummins INLINE™ 7 Explorer Utility* on page 48 of this manual.

14 Move on to **Step 2: Connect the INLINE™ 7 to a Vehicle**, next in this manual.
Step 2: Connect the INLINE™ 7 to a Vehicle

Once you have installed the INLINE™ 7 drivers, you are ready to connect the INLINE™ 7 to a vehicle using an adapter cable. The following adapters are included in the INLINE™ 7 kit:

- 6- and 9-pin “Y” Deutsch
- 2-pin Delphi/3-pin Deutsch (with battery clips)

Next, you connect the INLINE™ 7 to your PC using one of the following options:

- **A wired, USB connection** (pg. 31)

- **A wireless, Bluetooth® connection** (pg. 32)
  - Connecting via a Class 1, external Bluetooth® adapter (recommended)
  
  or

  - Connecting via Integrated Bluetooth®

- **A wireless Wi-Fi connection** (pg. 39)
  - Mini Access Point Mode (pg. 39)
  
  or

  - Infrastructure Mode (pg. 43)
Making a Wired USB Connection

To connect the INLINE™ 7 to your PC using a USB cable:

1. Connect the USB cable (i.e., an automotive A to Mini-B USB cable) to the USB port of the PC or laptop.

2. Connect the other end of the cable to the port on the bottom of the device.

3. Connect the DB26 female end of the appropriate adapter cable to the INLINE™ 7.

4. Attach the other end of the adapter cable (i.e., the Deutsch connector end) to the vehicle’s diagnostic connector.

NOTE:

The vehicle’s diagnostic connector is typically located under the dashboard on the driver’s side, or beside the driver’s seat. It can also be located in the engine compartment, near the electronic control module (ECM).

5. Move on to Step 3: Test the Connection (pg. 44).
Making a Wireless Bluetooth Connection

NOTE:

The INLINE™ 7 factory default is Bluetooth® mode in a Non-Discoverable status. To confirm that the device is in Bluetooth® mode, press the Reset button momentarily and the Wireless LED will illuminate blue.

The INLINE™ 7 Data Link Adapter is equipped with a Class 1 Bluetooth® module with a range of up to 100m when communicating with another Class 1 Bluetooth® device. Most PCs that feature Integrated Bluetooth® are equipped with a Class 2 Bluetooth® module, which limits the useful range to around 10m.

For maximum wireless range, the use of an external, Class 1 USB Bluetooth® adapter (sold separately) is recommended.

There are two connection options:

- Connecting via a Class 1, external Bluetooth® adapter (recommended)
- Connecting via Integrated Bluetooth®

The procedure for connecting via Integrated Bluetooth® is much the same as connecting via an external Bluetooth® adapter. To connect using your PC’s Integrated Bluetooth®, skip Steps 3 and 4 on page 33 of the following procedure.

Connecting via a Class 1, External Bluetooth Adapter

If you decide to employ an external, Class 1 USB Bluetooth® adapter, you will have to perform the following tasks:

- Disable your PCs Integrated Bluetooth® device
- Install the drivers supplied with the external adapter, if required

NOTE:

Depending on the Bluetooth® adapter you are using for your wireless connection, you may need to install the necessary Bluetooth® drivers. For some adapters the drivers will install automatically.

- Connect the INLINE™ 7 to a vehicle
- Pair the INLINE™ 7 with your PC (pg. 35)
To connect via an external Bluetooth adapter:

1. Click on the **Show Hidden Icons** arrow in your PC’s System Tray.

   The hidden icons are displayed.

   ![Hidden Icons](image)

   *Figure 3.10 Hidden Icons*

2. Right-click on the Bluetooth® icon 📢.

   **NOTE:**
   
   If your PC has Integrated Bluetooth, skip Steps 3 and 4 and move on to Step 5.

3. Click on **Turn Adapter Off** (option may not be available in all configurations).

4. Plug the **Class 1 Bluetooth® adapter** you have selected into an available USB port on your PC, and wait while Windows® installs the required drivers.

   **NOTE:**
   
   Depending on the Bluetooth® adapter you are using for your wireless connection, you may need to install the necessary Bluetooth® drivers. For some adapters the drivers will install automatically.

The following message is displayed:

**Installing device driver software.**

When the installation is complete, the following message is displayed:

**Your device is ready to use.**
Chapter 3 • Installing the Drivers and Setting Up the Device

NOTE:
Some Bluetooth® adapters may require you to configure a Bluetooth® environment. If this is necessary, an Initial Bluetooth Configuration Wizard screen will display at the conclusion of the adapter installation process. If this happens, use the CD that came with the adapter.

5 Connect the DB26 female end of the appropriate adapter cable to the INLINE™ 7.

6 Attach the other end of the adapter cable (i.e., the Deutsch connector end) to the vehicle’s diagnostic connector.

NOTE:
The vehicle’s diagnostic connector is typically located under the dashboard on the driver’s side, or beside the driver’s seat. It can also be located in the engine compartment, near the electronic control module (ECM).

—At this point, the Power LED (green) on the INLINE™ 7 should be illuminated (on).

—If the Power LED is not illuminated, turn the vehicle’s key to the ON position, leaving the engine off

7 Press and hold the Reset Button until the Wireless LED begins to flash blue (about 3 seconds).

This will put the INLINE™ 7 in Discoverable Mode. When the INLINE™ 7 is Discoverable, a host device can detect, pair, or connect to it. Once a connection is established, the LED turns solid blue. After two minutes, discoverability will time out, and the device will go back to Non-Discoverable status.

NOTE:
See Device Features in Chapter 2 of this manual for a detailed discussion of the Reset Button.

8 Move on to Pair the Device, next in this manual.
Pair the Device

You use the Windows® utility to pair the device (i.e., the INLINE™ 7 with your PC).

To pair the device:

1. Click on the Show Hidden Icons arrow in your PC’s System Tray.

   The hidden icons are displayed.

2. Right-click on the Bluetooth® icon 📡.

3. Click Add a Device.
The **Add a device** screen is displayed.

![Add a Device Screen](image)

**Figure 3.12 Add a Device Screen**

4. Select the device displayed that matches the serial number on the back of your INLINE™ 7 (e.g., **CIL7_xxxxxx**).  

---

*Cummins INLINE™ 7 Data Link Adapter Installation and Setup Manual*
Your selection is highlighted.

![Add a Device Screen Refreshed](image)

**Figure 3.13 Add a Device Screen Refreshed**

5 Click **Next**.

**NOTE:**

You may be prompted to enter a pairing code for the device. If you are prompted to enter a PIN or pairing code, enter **INLINE7** (all uppercase).
The following System Tray message is displayed.

Your device is ready to use.

6 Click Close.

7 Move on to Step 3: Test the Connection on page 44 of this manual.
Making a Wireless Wi-Fi Connection

When using Wi-Fi, the INLINE™ 7 can be configured for either of the following modes:

- Mini Access Point, the Wi-Fi default (pg. 39)
- Infrastructure (pg. 43)

NOTE:

INLINE™ 7 cannot be used in Infrastructure mode until it has been configured using the Explorer utility (see Using the Cummins INLINE™ 7 Explorer in Chapter 3 of this manual).

Mini Access Point Mode

The easiest and quickest way to connect your INLINE™ 7 to your PC is Mini Access Point mode. In Mini Access Point mode (also known as Access Point Emulation mode), the PC communicates directly with the INLINE™ 7. The INLINE™ 7 emulates the function of an access point, allowing the PC to connect directly to the INLINE™ 7, as if it were an access point. When the PC is connected to the INLINE™ 7 in Mini Access Point mode, neither device is connected to the company network.

![Mini Access Point Mode Diagram](image_url)
To connect the INLINE™ 7 to your PC using Mini Access Point Mode:

1. Connect the DB26 female end of the appropriate adapter cable to the connector on the top of the INLINE™ 7.

2. Attach the other end of the adapter cable (i.e., the Deutsch connector end) to the vehicle’s diagnostic connector.

**NOTE:**

The vehicle’s diagnostic connector is typically located under the dashboard on the driver’s side, or beside the driver’s seat. It can also be located in the engine compartment, near the electronic control unit (ECU).

—At this point, the **Power LED** (green) on the INLINE™ 7 should be illuminated (On).

—If the **Power LED** is not illuminated, turn the vehicle’s key to the ON position, leaving the engine Off.

3. Press and hold the **Reset Button** for about ten (10) seconds to switch from Bluetooth Mode (the factory default) to Mini Access Point Mode.

All of the LEDs on the device will flash momentarily to indicate that the device has been reconfigured. Once the connection is complete, the Wireless LED will display white to indicate Wi-Fi Mini Access Point Mode.

**NOTE:**

See **Device Features** in Chapter 2 of this manual for a detailed discussion of the Reset Button.

4. Navigate to the **System Tray** on your PC.

5. Click on the **Network** icon in the System Tray.

---

40  *Cummins INLINE™ 7 Data Link Adapter Installation and Setup Manual*
The **Network Selection** screen is displayed.

![Network Selection Screen](image)

**Figure 3.17 Network Selection Screen**

6 Select **CIL7_xxxxxx** from the list (where xxxxxx is the serial number of the INLINE™ 7).

**NOTE:**

If **CIL7_xxxxxx** is not displayed, make sure you are connected to the vehicle. Also, make sure you are within range (i.e., within 100 ft.). You may need to move your PC closer to the vehicle.
CIL7_xxxxxx is highlighted.

7 Click Connect.

8 Enter the Security Key located on the label on the back of the device.

9 Click OK.

The device is now connected and ready to use.

10 Move on to **Step 3: Test the Connection**, on page 44 of this manual.
Infrastructure Mode

In Infrastructure mode, your PC communicates with your company’s computer network through a Wireless Access Point (not included), which acts as a bridge between the wireless network and the wired network. In this mode, the INLINE™ 7 is configured to communicate with the same access point. All communication between the PC and the INLINE™ 7 passes through the access point.

NOTE:
The settings for connecting to your company network may differ from one installation to another. To ensure network security, your Information Technology (IT) administrator will need to oversee the installation and specify the appropriate configuration parameters. Your IT administrator should be able to properly configure the INLINE™ 7 for infrastructure mode, using the Cummins INLINE™ 7 Explorer utility (see Switching Modes: Mini Access Point and Infrastructure on page 51 of this manual).
Step 3: Test the Connection

You use the Cummins Communication Validation Tool to test the connection between the INLINE™ 7 and the vehicle. At startup, the Communication Validation Tool checks for any INLINE™ 7 drivers installed on the PC.

To test the connection between the INLINE™ 7 and the vehicle:

1. Click **Start** and then select **All Programs** ▶ **Cummins** ▶ **INLINE 7** ▶ **CumminsValidationTool**.

   The application is started and the **Communication Validation Tool** screen is displayed.

   ![Communication Validation Tool: Status Not Connected](image)

   **Figure 3.21 Communication Validation Tool: Status Not Connected**

2. Use the ▶ button in the **Driver** box to select the appropriate driver (i.e., **INLINE7 - CIL7R32**).

3. Use the ▶ button in the **Device** box to select the appropriate device (for example, INLINE7, Bluetooth).

   —The **Device** box lists all the devices supported by the INLINE™ 7 drivers installed on the PC.
4 Use the button in the Protocol box to select the appropriate protocol (e.g., J1939, CAN, ISO 15765, J1708).

— The Protocol box lists only the protocols supported by the device selected in the Device box.

5 Press the Start Test button.

The Communication Validation Tool screen is refreshed and the Connection Indicator button (located in the bottom left corner of the display) changes from Not Connected (red) to Connected (green).

![Communication Validation Tool: Status Connected](image)

**Figure 3.22 Communication Validation Tool: Status Connected**

The Vehicle Info window displays information about the vehicle to which you are connected (depending on the protocol selected).

The Modules Detected window in the middle portion of the screen displays a list of all systems seen on the bus. It is used for J1708 and J1939 only. For all other protocols this window will be unavailable (i.e., NOT USED).

The Bus Messages window at the bottom of the screen displays data received from the vehicle bus.
If the Connection Indicator button is red (i.e., Not Connected), do one of the following:

—For a wireless connection:

- In the Device list, make sure that the appropriate device is selected, for example:
  - INLINE7, Bluetooth
  or
  - INLINE7, WiFi
- In the Protocol list, make sure that the appropriate protocol is selected, for example SAE J1939 Protocol.
- Check to ensure that the connections between the INLINE™ 7 and the vehicle are secure (i.e., the Diagnostic Connector).
- Check to make certain that the Power LED on the INLINE™ 7 is illuminated.

—For a wired connection using a USB cable:

- In the Device list, make sure that the appropriate device is selected, for example INLINE7, USB.
- In the Protocol list, make sure the appropriate protocol is selected, for example SAE J1939 Protocol.
- Check to ensure that the connections between the INLINE™ 7 and the PC are secure (i.e., the USB cable).
- Check the connections between the INLINE™ 7 and the vehicle (i.e., the Diagnostic Connector).
- Check to make certain that the Power LED on the INLINE™ 7 is illuminated.

**NOTE:**

For additional information, refer to “Connect the INLINE™ 7 to a Vehicle” on page 30 of this manual.

6 Click on the Component Info button.
The **Component Information** window is displayed.

![Component Information Window](image)

**Figure 3.23** Component Information Window.

**NOTE:**

Component Information for Engines and Brakes is available only during a J1708 connection.

7 When you have finished viewing the information, click the **Close** button in the upper right corner of the window.

8 Click **Stop Test** to end the test, or select another device to test.
Using the Cummins INLINE™ 7 Explorer Utility

The Cummins INLINE™ 7 Explorer utility opened automatically when you installed the INLINE™ 7 drivers and utilities (see Figure 3.9, on page 29).

To re-open the Cummins INLINE™ 7 Explorer once it has been closed, click on the Show Hidden Icons arrow in your PC’s System Tray.

Then, double-click on the INLINE™ 7 icon.

NOTE:

You can also access the Cummins INLINE™ 7 Explorer from your PC’s Start menu. Click Start and then select All Programs → Cummins → INLINE 7 → INLINE 7 Explorer.
The **Cummins INLINE™ 7 Explorer** opens.

![Cummins INLINE™ 7 Explorer](image)

**Figure 3.25** *Cummins INLINE™ 7 Explorer*

The following menu options are provided:

- File *(pg. 53)*
- Tools *(pg. 54)*
- Help *(pg. 57)*

Each menu option includes a number of features. Each of the menu options are discussed in the following sub-sections.

When you click on a INLINE™ 7 in the list in the left pane, the Configuration tab is displayed (Figure 3.26).
The Configuration Tab

The Configuration tab provides the following information:

- Device:
  - Name
  - MAC Address
- Wireless Settings
- Internet Protocol (TCP/IP) Settings

This information can be useful when troubleshooting network connection problems. You also use the Configuration tab when switching between the two wireless Connection Types (i.e., Wireless and Bluetooth), or when setting up a Wi-Fi connection in Infrastructure Mode.

To access the Configuration tab:

1. Click on a CIL7_xxxxxx in the list in the left pane of the Explorer.

![Configuration Tab Image](image-url)
Switching Modes: Mini Access Point and Infrastructure

From the INLINE 7 Explorer Configuration tab, you can use the Mode drop-down menu under Wireless Settings to switch between Mini Access Point and Infrastructure modes.

NOTE:

For a graphic depiction of a typical Infrastructure Mode setup, see Figure 3.20, on page 43.

NOTE:

You can also use the Reset Button to switch from Infrastructure Mode back to Mini Access Point Mode (the Wi-Fi default). Just push and hold the button until the wireless LED changes color from orange to white (about 3 seconds).

Once, you have selected Infrastructure from the drop-down menu, additional fields in the Wireless Settings portion of the screen are available.
Chapter 3 • Installing the Drivers and Setting Up the Device

The following **Wireless Settings** fields are available:
- Network Name
- Frequency (used to switch between 2.4 and 5 GHz)
- Security (WEP, WPA/WPA2)
- Password
- Key Index (only available with the WEP security selection)

**NOTE:**

The settings for connecting to your company network may differ from one installation to another. To ensure network security, your Information Technology (IT) administrator will need to oversee the installation and specify the appropriate configuration parameters.

The **Internet Protocol (TCP/IP)** portion of the screen is also available to you to enter the required settings. There are two options:
- Obtain an IP address automatically (i.e., a dynamic IP address)
- Specify an IP address (i.e., a static IP address that does not change)
  - IP Address
  - Subnet Mask
  - Default Gateway

**NOTE:**

You will need to obtain this information (i.e., IP Address, Subnet Mask) from the designated IT person or network administrator for your location. Depending on how your local network is configured, you may also need to enter Default Gateway information.
The File Menu

The File menu has one feature, Exit. You use the Exit feature to close the Cummins INLINE™ 7 Explorer.

To exit the Cummins INLINE™ 7 Explorer:

1. Select **File** from the Cummins INLINE™ 7 Explorer menu bar.

2. Select **Exit**.

The Cummins INLINE™ 7 Explorer closes.
The Tools Menu

The Tools menu provides the following features:

- Ping
- Options

Ping

The Ping feature uses the PING protocol to check for the presence of a device on the network.

To check for a device:

1. Select Tools from the Cummins INLINE™ 7 Explorer menu bar.
2. Select Ping.

3. Enter the IP address of the device you want to locate (e.g., 192.168.123.107).
4. Click Start.

   The Cummins INLINE™ 7 Explorer searches for the device and, if found, displays the reply.

5. Click Stop.

6. Click the Close button on the dialog box.
Options

The Options feature provides the following features, which are presented as check boxes:

- Start INLINE 7 Explorer when Windows starts (pg. 55)
- Show New INLINE 7 Notification (pg. 56)

Start INLINE 7 Explorer when Windows Starts

You use this feature to manage when the Cummins INLINE™ 7 Explorer opens.

The default is to not open the Cummins INLINE™ 7 Explorer when Windows starts.

Figure 3.30 Options Menu

To change the default, click on the check box to add the check mark. Then click OK.
Show New INLINE™7 Notification

You use this feature to manage when to display the New INLINE™7 notification message box.

The default is to display the notification message box whenever a new INLINE™7 is detected.

To change the default, click the box to remove the check mark. Then click OK.
The Help Menu

The Help menu has one feature, About. You use the About feature to display information about the Cummins INLINE™ 7 Explorer.

To access the Help menu:

1. Select Help from the Cummins INLINE™ 7 Explorer menu bar.
2. Select About.

3. When you have finished reviewing the information, click OK to close the dialog box.

Figure 3.33 About Cummins INLINE™ 7 Explorer